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Search all of your disks, find and save one copy of all your original images in one 
convenient archive.
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Introduction

consolidateImages is a macOS application designed to gather together one copy of all your original images from all of 
your disks and store them in one Archive.  

consolidateImages will eliminate most duplicates, reduce conflict between different images with the same names, and 
rectify many date/time conflicts between camera times and file times.

You can have as many consolidateImages Archives as you would like, and you can move (or copy) and entire Archive 
from one disk to another.  

consolidateImages does not erase or delete any originals from your disks - it only makes copies into the Archive.

consolidateImages enables you to curate your entire set of all your originals and then selectively export them to Apple 
Photos.

consolidateImages enables you to directly send images through Apple Mail and Apple Messages.

consolidateImages enables you to directly print full resolution copies of your pictures, and has a unique 35mm-style slide 
output for printing multiple images with pertinent information on each one.

consolidateImages will find all your images - anywhere you let it look - inside your Photos Libraries, inside your Apple 
Mail, inside your Apple Messages, and wherever else you choose.

consolidateImages will let you search the archive for images with specific names, dates, types and other text 
characteristics.
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Limitations

1)  consolidateImages is NOT a conversion program.  The goal of the program is to find and copy originals, unchanged, 
into an Archive.  JPGs, PNGs, PSDs, TIFs, BMPs, GIFs, Raw Images, etc., are found wherever they are stored and all 
copied in their original format.  There is one exception to this: if the program is used on a computer running macOS 
Mojave (10.14), PICT files will be converted (if possible) to JPGs or PNGs, depending on their level of transparency.  The 
original PICT file will be copied to a special folder, and the converted file stored in the Archive.  Please note that this does 
NOT happen on computers running macOS Catalina (10.15) or later; the PICT file originals will be copied to a folder 
inside the Archive called “Images_That_Need_External_Quicktime_Conversion”.  (You can access this folder inside the 
Archive by checking under the File Menu -> Show Folders for -> Quicktime 7 Needed.)

2)  consolidateImages makes every attempt to identify duplicate images.  In some cases an image may visually appear to 
be a duplicate of another, but is either a different resolution, has been modified in some way or has been saved in a 
different format.  At this time consolidateImages does not differentiate these cases.

3)  consolidateImages will re-check all Sources in the sources list every it runs.  It is recommended that you remove 
sources from the list once you have completed your consolidation of that location.  You can add sources back to the list at 
any time, and only new, recently added or modified images will be found and copied to the Archive.  This is particularly 
useful to help find new images received in Apple Mail and Apple Messages from time to time.

4)  Export to Photos is supported only on computers running macOS Catalina (10.15) or later.

5)  Throughput and performance are directly tied to the speed of the computer’s CPU and graphics card, the amount and 
speed of memory, and the speed and type of the storage media for the archive and all of the sources.
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Create a New Archive

Launch the consolidateImages application from Finder. 

If no archive was previously created or selected, you will be asked to create a new one or choose an existing one.

Choose a location to store your Archive.  You might want to put it on an external drive, preferably SSD,  as speed makes a 
big difference.  If your Archive grows too large later, with too many images, you can move it to another larger disk.  At 
that future time, just drag the Archive “folder” to a new location.  Then either double-click on it to open it, or use Open 
Existing Archive under the File menu.  You can have as many Archives as you like, and rename them to whatever you 
want.  The initial name for any new Archive will always be “consolidateImages Archive.”
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The initial archive will be empty.

Note: your display needs to be set to a minimum of 1440 x 700 pixels.
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Open Archive

After you have created and archive and come back to it, or want to switch to another archive that you created, you can 
choose to open it directly.  To open a specific Archive, click Open Existing Archive under the File Menu.

Select the Archive and click Open.

Note: You can rename the Archives to whatever you would like, and have as many as you need.
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The Archive opens.
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Close Archive

To close a specific Archive, click Close Current Archive under the File Menu.

The Archive will close.  
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Choose Sources

Choose sources you’d like to search for images to add to your archive — click the Add Source icon in the toolbar.

Choose disks, folders or even individual images.  You can multiple-select folders or images at one time, but only one disk 
at a time. Click Add Source again to add as many sources as you would like.
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You may be asked for permission to access your photos - click Ok.

If you selected a protected folder on your computer (such as the root of the boot disk), you will be prompted 
automatically to “open” each of the main folders to examine for images.  An alert will pop up to explain this.  Just press 
Return or click Open each time you are prompted and permission will be granted to search and copy images from that 
folder and its sub-folders.  You will be asked this question for Desktop, Documents, Downloads, Movies, Music and 
Pictures, but not necessarily in that order.  This grants the program permission to search each of these folders.  If you do 
not want to search or include images from any of these specific folders, merely click Cancel when prompted.

Note: consolidateImages never modifies, moves or deletes ANY original material, files or folders on your disks - it will ONLY copy 
images to your chosen Archive.
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You can see each of the source locations that you chose above in the Sources List.
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Add Images from Mail

To search for and include images you have received in Apple Mail, click the Add Mail icon in the toolbar.

To grant permission to search Apple Mail, you must click Open in the folder prompt.
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Mail has been added as a source.
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Add Images From Messages

To search for and include images from Apple Messages: click the Add Messages icon in the toolbar.

Click Open in the folder prompt.
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Messages has been added as a source.
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Remove Source

If you no longer want to search or include images from a specific folder, click it in the Sources list and click the Remove 
Source icon in the toolbar.

Note: this does not remove or delete any images that have already been copied into the Archive.
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The sources have been removed:

Suggestion:  It’s a good idea to remove sources once you have completed consolidating them, as the program will always search all 
Sources in the list each time the program is run.  As your list gets longer, this can significantly increase processing time.  You can 
always add a source back into the list at a later date and the program will find any new images that have been added since the last time 
that source was searched.
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consolidate

The Consolidated tab must be selected in order to start the consolidate process.  

If the consolidate button is dimmed (not enabled) like below, one of the other tabs is selected.

Click the Consolidated tab and the consolidate button will be re-enabled.

With your sources added, click the Consolidate icon in the toolbar and the process of finding and copying the images into 
the Archive will begin.

Note: depending on the number of sources, the sizes of the folders or disks, the number of images, and the speed of each disk, the 
consolidate process can take a long time.

As the program prepares to start searching, it may ask again for specific permissions to search each of the principal User 
folders that you have chosen from your main System disk.  This may include Desktop, Documents, Downloads, Movies, 
Music and Pictures, but not necessarily in that order.  Click Ok for each prompt, unless you do not want the program to 
have access or search for images in that specific folder or its sub-folders.

Caution: If you click “Don’t Allow” the program will be prevented from searching these folders in the futures as well, even if the 
source is removed and then added back in the the Sources list.  You can change this setting later in macOS System Preferences -> 
Security & Privacy -> Privacy.The process begins by Finding all the images among all the folders (Directories), and then 
copies them to the Archive.  Along the way, the progress dialog will show you the status of the copying.  As images are 
added to the Archive, they will appear in the collection.  You can cancel the finding or copying at any time, and the start 
the Consolidate process again later.  In most cases it will pick up where it stopped.
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The consolidation process can be quite lengthy, as along the way the application is performing multiple types of checks 
for duplicates.  The example below is from an eight-year-old 2012 MacBook Pro with 8GB Ram, 2.6 GHz, running macOS 
10.14.6, processing an old 4TB 7200RPM hard disk and saving the archive onto a 2TB SSD.  consolidateImages found 300k 
images spread across 31k directories on the 4TB hard disk.  Initially it determined that 195k were duplicates.  It copied 92k 
originals into the archive on the 2TB SSD and along the way it identified an additional 13k duplicates.  It took over twenty 
hours to complete.  Your results will depend entirely on the speeds of your computer and disk drives.

Note: While the program strives to not copy any duplicates that it can accurately determine, duplicate identification is not perfect.  In 
some cases, images that are very similar may be copied, for example, if they are different sizes, or saved with different resolutions or 
different formats.
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When consolidation is complete for the current sources, the results will be displayed.
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As you add more source and run Consolidate again and again, the Lifetime totals will be accumulated in the Archive 
Details / Statistics panel.  The Statistics display only updates after a consolidate session is completed.
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Explore the Archive

Images in the Archive are initially shown as a collection sorted by the date they were added.  You can view the images via 
different tabs for Consolidated, By Date, By Camera, By Filetype, By File Extension, By User, By Session and By Hidden.  

Controls at the bottom of each tab allow you to Rotate, change thumbnail size, change sort order, search the images on 
that tab, hide, delete or purge images.  The total count is for images displayed on that tab.

If an image’s thumbnail view needs to be rotated, select it, and click “Rotate”.

. . 

(Note: this does not rotate the original image, it only rotates the thumbnail view in the archive.)



Woula Software LLC - consolidateImages - User's Guide 23

June 3, 2020
Copyright © 2012-2020, Woula Software LLC. All rights reserved.

Apple, the Apple logo, Mac and macOS are trademarks of Apple Inc., registered in the U.S. and other countries.

You can change the displayed view of each image with the Thumb Size slider.  

Make them as large as possible:
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Or make them as small as possible:

Use the pop-up menu to change the sort order within each tab.

The other controls at the bottom of the tabs are discussed in the following sections on Search, Hide, Delete or Purge.
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Search the Archive

At the bottom of each Tab is a standard Search box. 

Searches will find images that contain a text representation of what you are searching for, looking in the filename, creation 
date, file type, file extension, camera model and camera maker.  (In the example below, the search found three images 
with the word “winnie” in their filename.)
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Hide Images

If you see images you’d like to hide, select them and click Hide.  

This does not delete them, it merely takes them out of view.
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In this example, 4 images were hidden.

Click the By Hidden tab to see any hidden images.  

To restore them to the main views, select them and click Unhide.
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Delete or Purge Images

Caution: DELETE AND PURGE ARE NOT REVERSIBLE. 

DELETE:  If you would like to remove one or more image(s) from the Archive,  but want the Archive to remember the 
image(s) were found (in other words, to prevent those images from being added back into the Archive again later), select 
one or more image(s) and then click Delete.  This removes the image(s), but the Archive remembers all the details about 
them and that they were previously found. They will never be added back into the Archive, regardless if you search and 
“find” those images in a different location.  The only way around this, if you need to have those images again, is to create 
a new Archive.

PURGE:  To permanently purge images from the Archive, to completely forget about them and to erase all traces of them, 
including any evidence that the images were found, select the images, and click Purge.  (Contrary to the way Delete 
works as described above, if you search the same location, disk or folder again, the Archive does not remember the previous results 
and those images will be found and added back into the Archive.)
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Export to Photos

Note:  Export To Photos is only supported on computers running macOS Catalina (10.15) or later.

By design, consolidateImages exports photos only to your System Photos Library.  

You may have more than one Apple Photos Library, and want to export from consolidateImages into a specific Photos 
Library.  It must be designated as the System Photos Library to do this.  This is easy to check and to change.

Open the specific Photos  Library you want to use.  (In this example, “Other Photos Library”)
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In the Photos application, select Preferences under the Photos menu, and in the General tab, check to see if your chosen 
Photo Library is being used as the System Photo Library.

If your chosen Photo Library is not being used as the System Photo Library, click Use as System Photo Library:

You can close the dialog and quit Photos.  (For this example, when you Export to Photos in consolidateImages, it will ask 
you to choose “Other Photos Library”.)
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In consolidateImages, select the images that you want added to your Photos Library and click the Export to Photos icon in 
the toolbar.  

Remember: Export To Photos is only supported if the computer is running macOS Catalina (10.15) or later.

You will be asked one more time to select that Library that you have set as the System Photos Library.  Select it and click 
Open.

Export progress will be shown and can be cancelled.

Note: Exporting can be a very lengthy process, depending on how many images you have chosen.
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The result of the export will be shown.

Exported images will be in your Photos Library.
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Email Images

To send images with Apple Mail, select the images and click Send Via Email icon in the toolbar.

The images will be added to an email for you to address and send:
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Send Images via Messages

To send images through Apple Messages, select the images and click Send Via Messages icon in the toolbar.

The images will be added to a message for you to address and send:
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Copy Images to Folder

To copy images out of the Archive, select them, click Copy to Folder and then pick the folder you want to copy them to.

You can copy images out to any location you choose.  This does not change the content of the Archive.
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Create a new folder for the images you want to copy or choose an existing one:

Click Open on the chosen location and the copy will proceed.
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The copying may take some time; progress will be shown.  You can cancel, if necessary.  If a copy of a specific image is 
already in the folder you selected, it will not be replaced, nor a duplicate added.

When copying is compete, the folder opens.
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Print Images

You can print images directly.  Choose the ones you would like to print and click the Print icon in the toolbar.

You can either print individual images at full resolution, or you can print a contact sheet of multiple images in the style of 
35mm slides.  

Click Fullsize Images to print individual images on separate pages.  Choose the paper settings appropriate for your 
output and printer, for example, borderless 4x6 prints at Best Quality on Photo paper:

To print multiple images per page, select the images and click the Print icon in the toolbar:



Woula Software LLC - consolidateImages - User's Guide 39

June 3, 2020
Copyright © 2012-2020, Woula Software LLC. All rights reserved.

Apple, the Apple logo, Mac and macOS are trademarks of Apple Inc., registered in the U.S. and other countries.

Select 35mm-style Slides.  Choose to rotate or not, and to sort by Filename or by Creation Date.

Note Rotate Portrait Layout Images will maximize the image to fit into the output slide; if  it is turned off, all images will be printed 
as they appear in the selection.

The 35mm-style output will put multiple images on each page, and as many ages as necessary to include all 
the selected images.  (Note: if the number of elected images is large, it can take a long time to prepare the output.). The 
slide view includes pertinent information for each image.
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Open Images or Show MetaData

Right-click on an image to get a contextual menu giving you multiple choices.

You can open a copy of the image in either the computers default external editor or Preview.

You can examine the image metadata.  (Changes to the image metadata are not saved.)
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Reset Preferences

Certain dialogs have the ability to turn off their warnings; if you have done so and want to restore those warnings, click 
Preferences under the consolidateImages menu.

Click Reset Warnings and Alerts.

You also have the ability to tweak the amount of parallel processing performed when consolidate is run.

CAUTION: You can experiment (at your own risk) with the aggressiveness of parallel processing applied during the 
consolidation process.  At “none”, images are processing one at a time.  Obviously, this takes the longest amount of time.  At the 
default level, approximately 16 images are processed in parallel.  At extreme, up to 48 images are processed in parallel.  Higher 
numbers can reduce the accuracy of duplicate finding, as multiple copies of the same image could be found, processed and saved nearly 
simultaneously.  Higher numbers do not necessarily mean it will run faster or complete the consolidation sooner.  Throughput and 
performance are directly tied to the speed of the computer’s CPU and graphics card, the amount and speed of memory, 
and the speed and type of the storage media for the archive and all of the sources.
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Purge Archive

To permanently erase an entire Archive and all traces of it, click Purge Current Archive under the File menu.  

CAUTION: This is not reversible!!
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Show Debug information

To see Debug information, click Show Debug Info under the Help menu.


	Introduction
	Limitations
	Create a New Archive
	Open Archive
	Close Archive
	Choose Sources
	Add Images from Mail
	Add Images From Messages
	Remove Source
	consolidate
	Explore the Archive
	Search the Archive
	Hide Images
	Delete or Purge Images
	Export to Photos
	Email Images
	Send Images via Messages
	Copy Images to Folder
	Print Images
	Open Images or Show MetaData
	Reset Preferences
	Purge Archive
	Show Debug information

